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1. Getting started in SpEd Forms 
 
SpEd Forms allows access to up-to-date due process forms from any computer with internet access.  
The completed forms can also be printed from any computer.  No special software needs to be installed 
on the computer. 
 
Student information is stored on the SpEd Forms server.  The SpEd Forms administrator controls 
access to the server and IEP managers control access to student records.  There is no need for you to 
backup information on a disk because all backups are performed by SpEd Forms. 

1.1 Configuring your computer 
 
Internet Explorer is recommended for Windows operating systems.  For Mac OS X users, we 
recommend Opera.  If you use Mac OS, please refer to the Mac Test Results page at: 
http://spedforms.com/support/mac_test_results.htm. 
 
1.1.1 Instructions for Windows users (Recommended: Internet Explorer) 
Download the latest version of Internet Explorer at:  www.microsoft.com 
 

Step 1: Editing setup 

1. Open Internet Explorer. 
2. Select "Internet Options" from the "Tools" menu. 
3. In the "Browsing History" section (IE 6: 

"Temporary Internet Files"), click "Settings". 
4. Under "Check for newer versions of stored pages" 

click "Every visit to the page".  Click "OK". 
5. Select the "Security" tab and click on the "Custom 

Level..." button. 
6. In the "Miscellaneous" section - enable "Display 

Mixed Content" (When you click "OK" you will be 
asked if you want to change the security settings. 
This is to prevent a warning box from being 
displayed in "Design Mode", it has nothing to do 
with the security of your computer. See NOTE 
below.) 

 
NOTE: If you do not enable "Display Mixed 
Content" a warning box will be displayed every time you use "Design Mode" in ER Forms. 

 
Step 2: Printing setup 

1. Select "Page Setup" from the "File" menu. 
2. Delete any characters in the box labeled "Header". 
3. Delete any characters in the box labeled "Footer". 
4. In the "Margins" section, change all margins to ".5".  Click "OK". 
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Step 3: Printing background images 

1. Select "Internet Options" from the "Tools" menu. 
2. Click on the "Advanced" tab. 
3. In the "Settings" section, scroll down to "Printing". 
4. Make sure there is a check in the "Print background 

colors and images" check box. 
5. Click the "Apply" button and then click "OK". 

 
NOTE: If you do not enable the option for printing 
background images, the "DRAFT" image will not appear 
in the background of your printed IEP when the 
"DRAFT" option has been chosen. 

 
 
 
 
 
1.1.2 "Opera" Setup Instructions for Mac OS X users (Recommended) 
Download the latest version of Opera at:  http://www.opera.com 

 
Step 1: Editing setup 

1. Open Opera. 
2. Select "Preferences..." from the "Opera" menu. 
3. In "Advanced" settings, click on "Cookies" 

and make sure "Accept Cookies" is selected. 
4. In "Advanced" settings, click on "History" and 

update the following. 
· Set "Memory cache" to Off 
· Set "Disk cache" to Off 
· Set "Check documents" to Always 
· Set "Check Images" to Always 

5. Make sure to click "OK" when you are 
finished making changes. 

 
Step 2: Printing setup 

1. When you are ready to print a form, select "Print" from the "File" menu. 
2. Select "Opera" from the drop down menu 

currently labeled "Copies & Pages". 
· "Print Background" should be checked 
· "Print Headers and Footers" should be 

unchecked 
3. Select "Save As..." from the "Presets" drop 

down list (select "Save" [as shown in inset] if you 
already have a "Default" preset). 

4. After you have made these choices, click on 
"Print" (these last steps may not be saved if you do not follow through with the print process). 

 

 2 



1.1.3 "Firefox 3" Setup Instructions for Mac OS X users 
Download the latest version of Firefox 3 at:  http://www.mozilla.com/en-US/firefox 

 
Step 1: Editing setup 

1. Open Firefox 3. 
2. Select "Preferences" from the "Firefox" menu. 
3. In "Advanced" settings, select the "Network" tab 

and in the Cache section change the value to 0 
(zero) for "Use up to 0 MB of space for the cache". 

4. In "Advanced" settings, select the "Update" tab and 
uncheck all boxes (when Firefox is set to 
automatically update, crucial settings can be lost). 

5. Close the Preferences window. 
 

Step 2: Printing setup 

1. When you are ready to print a form, select "Print" 
from the "File" menu. 

2. Select "Firefox" from the drop down menu 
currently labeled "Copies & Pages". 

3. In the "Page Headers" &amp; "Page Footers" 
sections change all drop down list to "(Blank)". 

4. Select "Save As..." from the "Presets" drop down 
list (select "Save" [as shown in inset] if you already 
have a "Default" preset). 

5. After you have made these choices, click on 
"Print" (these last steps may not be saved if you do not follow through with the print process). 

 
Setting Margins in Firefox 3 

1. Select "Page Setup" from the "File" menu. 
2. Next to "Paper Size", select "Manage Custom 

Sizes...". 
3. Click the "+" sign toward the bottom left of the 

"Custom Page Sizes" window (this will add a 
page called "Untitled", double click "Untitled" 
and you can type in a new name, e.g. "SpEd 
Forms"). 

4. Select this new "Page Size" by clicking once on 
it's name (it should be highlighted, blue). 

5. Set the width: 8.50, Height: 11.00 and make sure 
Printer Margins is "User Defined".  Set all margins to the recommended 0.50 inches. 

6. Click "OK" and make sure the new custom size you just created is selected next to "Paper Size" 
and Click "OK" for the "Page Setup" window. 
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1.2 Accessing SpEd Forms 
 
You will receive a server address, 
username, and password from your SpEd 
Forms administrator.  Keep this 
information safe, you will need to use it 
each time you log on to SpEd Forms. 

1. Type the server address into the 
"Address" box of your internet 
browser. 
 
NOTE: You may want to 
"Bookmark" the login page so that 
you do not have to enter it each 
time you access SpEd Forms. 
 

2. You will be taken to a log in screen where you can enter your username and password. 
3. Click "Enter" and the SpEd Forms main menu will appear. 
4. Take note of any new messages you may have.  If a teacher has requested access to a particular 

student (see section 2.2.5 for more information), you can take care of this task and then delete 
their request by clicking on the "Delete" link next to this entry (also see section 2.2.6). 

 
1.3 Changing your user profile 
 
Your user profile is initially set-up by the 
SpEd Forms administrator for your 
district.  You can change some of this 
profile information or add information 
that the administrator did not enter. 
 

1. Navigate to the "Main Menu". 
2. Click on the "Your Setup" button. 
3. On the "Your Setup" menu, click 

on "Profile". 
4. On this page you will notice the 

information that your SpEd Forms 
administrator had entered. 

5. Make the necessary changes and/or 
type in any new information. 

6. Click the "Save" button when you 
are finished making changes. 
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1.4 Managing your custom goal bank 
 
Each SpEd Forms user has their own custom goal bank.  You can Add, Edit or View your custom goals 
through the "Goals" menu in "Your Setup".  When you enter custom goals they will be available on 
any goal page when you click on "Choose Goal" and then specify "My Goal Bank" as the goal bank.  
 
To navigate to your custom goal bank: 

1. Navigate to the "Main Menu". 
2. Click on the "Your Setup" button. 
3. On the "Your Setup" menu, click on "Goals". 

 
To Add a new goal: 

1. Click on "Add Goal" from the 
"My Goal Bank" menu. 

2. Choose a "Category" and then a 
"Subcategory" (subcategories will 
change when the category is 
changed). 

3. Fill in the "Goal" and add as many 
"Objectives" as necessary. 
 
NOTE: Use the letter combination 
CHLD in place of the student's 
name.  When you import one of these goals into your goal page the letter combination "CHLD" 
will be automatically replaced with the student's first name. 
 

4. Click the "Save" button when you are finished making changes. 
 
To Edit an existing goal: 

1. Click on "My Goal List" from the "My Goal Bank" menu.  The "Goal List" shows all of the 
custom goals you have entered. 

2. Click on the "Edit" button next to the goal you want to update. 
3. Update the goal where necessary 

by changing the category, 
subcategory, goal or objectives 
(you can also add/delete 
objectives). 

4. Click on the "Save" button when 
you are finished making changes. 

 

To Delete an existing goal: 

1. Click on "My Goal List" from the "My Goal Bank" menu.  The "Goal List" shows all of the 
custom goals you have entered. 

2. Click on the "Delete" button next to the goal you want to delete. 
3. The goal will be deleted and the list will be refreshed. 
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1.5 Your custom measures bank 

 
Enter commonly used measures into your custom measures bank.  These measures can be used to keep 
track of and graph the progress of any goal or objective. 
 
To Navigate to your custom measures bank: 

1. Navigate to the Main Menu. 
2. Click on the "Your Setup" button. 
3. On the "Your Setup" menu, click 

on "Measures". 
 
To Add a new measure: 

1. Enter the measure's name and max 
score in the blank spaces provided 
next to the word "(Add)". 

2. The new measure(s) will be added 
once the page is "Saved" (more 
blank spaces will also be added). 

 
To Edit an existing measure: 

1. Make changes to any of the existing values as needed. 
2. Changes to the measure(s) will be saved once the page is "Saved". 

 
To Remove an existing measure: 

1. Put a check in the (Remove) checkbox next to the measure you wish to remove. 
2. The measure(s) will be removed when the page is "Saved". 
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1.6 Your custom team member list 

 
Enter commonly used team members into your custom team member list.  Once entered into the list 
you will be able to quickly and easily add them to the team members sections of forms such as the IEP 
and the "Notice of a Team Meeting" without re-entering the team member name and title. 
 
To Navigate to your custom team member list: 

1. Navigate to the Main Menu. 
2. Click on the "Your Setup" button. 
3. On the "Your Setup" menu, click 

on "Team Member List". 
 
To Add a new team member: 

1. Enter the team member's first 
name, last name and title in the 
blank spaces provided next to the 
word "(Add)". 

2. The new team member(s) will be 
added once the page is 
"Saved" (more blank spaces will 
also be added). 

 
To Edit an existing team member: 

1. Make changes to any of the existing values as needed. 
2. Changes to the team member(s) will be saved once the page is "Saved". 

 
To Remove an existing team member: 

1. Put a check in the (Remove) checkbox next to the team member you wish to remove. 
2. The team member(s) will be removed when the page is "Saved". 
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1.7 Your custom credentials 

 
Keep track of your education license information, it's numerical code and expiration date. 
 
To Navigate to your custom credentials: 

1. Navigate to the Main Menu. 
2. Click on the "Your Setup" button. 
3. On the "Your Setup" menu, click 

on "Credentials". 
 
To Add a new credential: 

1. Enter the name, number and 
expiration date in the blank spaces 
provided next to the word "(Add)". 

2. The new credential(s) will be 
added once the page is 
"Saved" (more blank spaces will 
also be added). 

 
To Edit an existing credential: 

1. Make changes to any of the existing values as needed. 
2. Changes to the credential(s) will be saved once the page is "Saved". 

 
To Remove an existing credential: 

1. Put a check in the (Remove) checkbox next to the credential you wish to remove. 
2. The credential(s) will be removed when the page is "Saved". 
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1.8 Your custom materials and procedures 

 
Once your commonly used materials, procedures and evaluators are entered into SpEd Forms you can 
attach them to any "Notice of an Educational Evaluation/Reevaluation Plan" without retyping. 
 
To Navigate to your custom materials and procedures: 

1. Navigate to the Main Menu. 
2. Click on the "Your Setup" button. 
3. On the "Your Setup" menu, click 

on "Commonly used Materials and 
Procedures". 

 
To Add new materials and procedures: 

1. Enter the evaluation area, 
materials/procedures and 
evaluators in the blank spaces 
provided next to the word "(Add)". 
 
NOTE: If the area you need is not 
listed in the area list, type it under 
"Other Area". 
 

2. The new custom area(s) will be added once the page is "Saved" (more blank spaces will also be 
added). 

 
To Edit existing materials and procedures: 

1. Make changes to any of the existing values as needed. 
2. Changes to the custom area(s) will be saved once the page is "Saved". 

 
To Remove existing materials and procedures:  

1. Put a check in the (Remove) checkbox next to the custom area you wish to remove. 
2. The custom area(s) will be removed when the page is "Saved". 
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1.9 Your drop down lists 

 
Most of the drop down lists in SpEd Forms can be managed by the super administrator.  The super 
administrator can also choose to allow users access to edit 
any of these lists.  When you are allowed to add to a 
specific drop down list, a link will be provided on this 
page.  When you add entries to a specific category, those 
additional entries will be available throughout SpEd Forms 
but will only be available to you.  No other teacher will be 
able to see your additional entries nor will they be able to 
manage them. 
 
NOTE:  In the inset (to the right) notice 
the additional choices added to this user's 
drop down list for "Course to be taken". 
 
To Navigate to your drop down lists: 

1. Navigate to the Main Menu. 
2. Click on the "Your Setup" button. 
3. On the "Your Setup" menu, click 

on "Edit drop down lists". 
 
To Add to a specific drop down list: 

1. Enter the order, value and display 
in the blank spaces provided next 
to the word "(Add)". 
 
NOTE: The "Value" is what is 
saved into the SpEd Forms 
database.  Sometimes the value needs to conform to a specific format (a number, no more than 
two characters, must match what is in Display, etc.).  Please contact your SpEd Forms 
administrator if you need additional assistance determining the value setting. 
 

2. The new drop down list entries will be added once the page is "Saved" (more blank spaces will 
also be added). 

 
To Edit existing drop down lists: 

1. Make changes to any of the existing values as needed. 
2. Changes to the drop down lists will be saved once the page is "Saved". 

 
To Remove existing drop down list entries: 

1. Put a check in the (Remove) checkbox next to the drop down list entry(s) you wish to remove. 
2. The drop down list entry(s) will be removed when the page is "Saved". 
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1.10 Your custom calendar 

 
On your calendar page you will automatically be notified of important dates for any student that is 
shared to your account and special events that are scheduled by administrators.  If the proper dates are 
entered for each student, their IEP date, 
IEP meeting date, IEP due date and 
evaluation due date will be shown on your 
calendar.  You can also add events to your 
calendar to remind you and other team 
members of important dates. 
 
To Navigate to your calendar:  

1. Navigate to the "Main Menu". 
2. Click on the "Calendar" button. 
3. You can click on the arrows next 

to the month/year to go forward or 
back to a particular month. 

 
To Add events to your calendar:  

1. Navigate to your "Calendar". 
2. Find the correct month (click on 

the arrows next to the month/year 
to go forward or back to a 
particular month). 

3. Click on the "Add" link next to the date for which 
you want to add an event. 

4. Choose the student's name and fill in any other 
pertinent information.  Uncheck the "Share event 
with team members" if this is a personal event. 

 
NOTE: The "Time" and "Title" will be displayed 
on your calendar.  The "Title" will appear as a link 
and you can click on this link to delete or make 
changes to this event. 

 
5. Click on the "Save" button to save your changes. 

 
To Edit events on your calendar:  

1. Click on the link to a specific event that you or a team member has created. 
2. Make any necessary changes. 
3. Click on the "Save" button to save your changes. 

 
To Delete events on your calendar:  

1. Click on the link to a specific event that you or a team member has created. 
2. Click on the "Delete Event" button. 
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2. Working with students 
 
 
 
 
 
 
 
2.1 Setting up your students 
 
Only IEP managers or others assigned the correct authority by your SpEd Forms administrator may 
create new student records. 
 
2.1.1 Add a new student 
 

1. Navigate to the "Main Menu". 
2. Click on "Work with students". 
3. You will then see a list of all your 

students (shown with a pink 
background) and those that other 
IEP managers have shared with 
you (shown with an ivory background). 

4. Click on the "Add New Student" button to add a student or click on the "Pickup Student" button 
to obtain the record for a student that is on another SpEd Forms server (see section 2.2.4). 

 
NOTE: If this screen does not 
have the "Add New Student" 
button you are not set up as an IEP 
manager or you have not been 
given access to create new student 
records.  Contact your SpEd 
Forms administrator if you feel 
your status needs to be changed. 

 
5. Fill in any known information on 

the setup page. 
6. Click the "Save" button. 
7. The student will now be added to 

the list. 
 
NOTE: Status, Student/MARSS ID, First 
Name, Last Name and Serving District are 
required. 
 
You can click on any of the drop down 
boxes to see a list of choices. 
 
Click on any link to get a more detailed description.  The link for the "Federal Setting" will take you to 
a list of settings and descriptions of settings for various ages.  You will need to close this new window 
and choose the setting number from the choices in the drop down box. 
 

NOTE:  Give special attention to saving, printing and navigation instructions: 
· Always click the "Save" button after information is entered or changes are made. 
· Always use the SpEd Forms "Print" button, instead of selecting "Print" in the "File" menu. 
· Always use the SpEd Forms "Back" button rather than the browser's "Back" feature. 
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2.2 Student setup 
 
Besides administrators with edit privileges, only IEP managers and those with edit access may edit the 
student's setup or exit a student from SpEd Forms. 
 
NOTE: On the "Form Menu", shared students will have "View case manager | Remove from my list" 
displayed under the student's name.  Use these links to Remove a student from your caseload or view 
information about the case manager. 
 
2.2.1 Editing student setup (you must 
have edit access to this student) 
 

1. From the "Main Menu" click on 
"Work with students". 

2. Click on the student's name or the 
"Work on this record" button. 

3. On the "Form Menu" click on the 
"Edit Setup" button. 

4. Make changes as needed and click 
on the "Save" button. 

5. Click "Form Menu" to return to 
the form menu for this student. 

 
NOTE: The "MARSS" button will 
only show up for those students that 
have a MARSS compliant Student/
MARSS ID (no more than 13-digits). 

 
2.2.2 Student sharing (case managers 
only) 
 

1. From the "Main Menu" click on 
"Work with students". 

2. Click on the student's name or the 
"Work on this record" button. 

3. On the "Form Menu" click on the 
"Student Sharing" button.  

4. You will be taken to a page 
showing users with access to that 
student and the users which are available. 

5. Click on the "Select a User" drop down box. 
6. Select a category or "View All" and a screen will appear listing all available users. 
7. Select the desired user by clicking the "Share" button next to that person's name. 
8. The user's name will then appear in the list on the right. 
9. If this user should be able to edit the forms, click the "Edit Access" box.  If the box is not 

checked, the user will have read only access. 
10. To remove a user from the list, click on the "Unshare" button to the left of that person's name. 

 
NOTE:  "(Case Manager)" will appear next to your name (do not remove your "Edit Access").  
Clicking on the link to a users name will display a staff profile information box.  Their name, title, 
location, phone, fax and email will be shown (if this information is available in their record). 
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2.2.3 Send the student to a new IEP manager (case managers only) 
 

1. From the "Main Menu" click on 
"Work with students". 

2. Click on the student's name or the 
"Work on this record" button. 

3. On the "Form Menu" click on the 
"Student Sharing" button. 

4. Click on the "Send this student to 
a new case manager" button. 

 
2.2.3.1 Send student to a local manager 
 
Most charter schools and cooperatives can 
easily reassign IEP managers via the local 
method. 
 

1. Navigate to the "New Case 
Manager" screen (section 2.2.3). 

2. In the top box labeled "SEND 
[STUDENT] TO A LOCAL IEP MANAGER", click the drop down box to see all available managers. 

3. Scroll down until the correct name is displayed and click on the name. 
4. Click "Send" to send the student to that IEP manager (If you no longer need to have access to 

this student, put a check in the box labeled "Reset current student sharing"). 
 

NOTE: After a new IEP manager is assigned, only the new IEP manager can set student sharing. 
 
2.2.3.2 Send student to a remote manager 
 
If the student is moving to a school/district outside of 
your district or service cooperative and their SpEd 
Forms web address is different from yours, the new 
school can use the "Pickup Student" feature to 
securely obtain the student's current information. 
 

1. Navigate to the "New Case Manager" screen 
(section 2.2.3). 

2. In the bottom box labeled "SEND [STUDENT] 
TO A REMOTE IEP MANAGER", fill in your 
phone number, the new IEP manager's name 
& the new IEP manager's (10 digit) fax 
number. 

3. Click on the "Create Fax" button (this will 
create a faxable cover sheet with information 
that the remote IEP manager will need to 
pickup this student). 

4. Print this page and fax it to the new IEP 
manager. 

 
NOTE: This procedure is used to inform the school of your server address and create the pickup 
code they will use to import the data.  The student will remain on your system until they are exited. 
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2.2.4  Pickup a student 
  

1. From the "Main Menu" click on 
"Work with students". 

2. Click the "Pickup Student" button. 
3. Fill in the server address and 

pickup code listed on the fax you 
received from the remote school 
district and click "Next". 

4. Create the new record.  If you are 
given the option to "Update" the 
record, be advised that this will 
replace all current information with that from the remote server (if recent changes have been 
made to this student's record, those changes may be lost). 

 
NOTE:  If the server address and/or pickup code were typed incorrectly, you may get a message stating 
such and be given an opportunity to "Try Again".  Ensure all information is correct (must be a secure 
server address, "https://...").  If you continue to get this message, the pickup code may have expired.  
Contact your SpEd Forms administrator. 
 
2.2.5  Request access to a student 
  

1. From the "Main Menu" click on 
"Work with students". 

2. Click the "Request Student" 
button. 

3. Fill in the first and last name of 
the child you want access to and 
click on the "Next>>" button. 

4. A list of students will appear that 
match the name that you entered.  
Click on the "Request" button next 
to the student you want access to. 

5. A confirmation will then appear, 
confirming that a message has 
been sent to the teacher. 

 
2.2.6  Managing the "Messages Inbox" 
 
The "Messages Inbox" appears toward the bottom of the Main Menu.  You can check your messages at 
any time by navigating to the "Main Menu".  If a request for access appears in your massages, you can 
navigate to the "Student Sharing" page for that student (see section 2.2.2 for more information), add 
sharing for the sender (if appropriate) and then "Delete" that entry from your messages. 
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2.2.7 Exit a student (you must have edit access to this student) 
 

1. From the "Main Menu" click on 
"Work with students". 

2. Click on the student's name or the 
"Work on this record" button. 

3. On the "Form Menu" click on the 
"Edit Setup" button. 

4. Select a new "Status" and/or 
"Status End (Exit Reason)". 

5. Update any pertinent information. 
6. Click on the "Save" button to save 

your changes. 
 
NOTE: You must choose either an 
"EXIT" Status OR an "EXIT" Status End 
(Exit Reason) to inactivate the student.  
The exited student will then disappear 
from your list of active students. 
 
2.2.8 Reactivate an inactive/exited 
student (you must have edit access to this 
student) 

1. From the "Main Menu" click on "Work with students". 
2. Make sure there is a check in the "Show inactive/exited students" checkbox. 
3. Click on the student's name or the "Work on this record" button. 
4. On the "Form Menu" click on the "Edit Setup" button. 
5. Select a new "Status" AND clear or choose a valid "Status End (Exit Reason)". 
6. Click on the "Save" button to save your changes. 

NOTE: Ensure that neither the Status nor the Status End (Exit Reason) have an "EXIT" value (you 
can choose "---Clear---" for the Status End (Exit Reason) to clear out its value). 
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2.3 Working with student information 
 
2.3.1 Your student list 
 

1. From the "Main Menu" click on 
"Work with students". 

2. A list of students you have access 
to will appear. 

 
NOTE: These are either students 
you have setup (shown with a pink 
background) or ones assigned to you by another IEP manager (shown with an ivory 
background).  

 
3. To work with student information, click on the "Work on this Record" button next to the 

appropriate student.  Your student list also provides you information about important dates at a 
glance.  Green smiley faces indicate dates appear to be entered correctly.  Red and orange faces 
indicate important dates have not been entered or need to be edited/adjusted (for more 
information, click on the appropriate face). 

 
2.3.2 Navigate to forms 
 

1. From the "Main Menu" click on 
"Work with students". 

2. Click on the "Work on this 
Record" button next to the 
appropriate student. 

3. This will take you to the forms 
menu for that student. This menu 
lists all the forms available in 
SpEd Forms including the IEP, 
IFSP, IIIP, Evaluation Report and 
many other additional forms. 

4. To navigate to a form, click on the 
form's name.  You will be taken 
either to the form or, in the case of 
multiple-page forms, a listing of 
the pages within that form. 

 
2.3.3 The forms menu 
 

The forms menu lists all form 
templates available in SpEd Forms. 
Form templates which are replicates 
of forms posted on the Department of 
Education web site are marked with 
an "*".  The other forms have been 
developed over the years in conjunction with various school districts.  If "Active" appears next to 
the service plan, the student is currently on that plan.  You can change which form is "Active" by 
clicking on "Edit Setup" and changing the "Service Plan". 
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2.3.4 View/Delete a student's history 
 

1. From the "Main Menu" click on 
"Work with students". 

2. Click on the "Work on this 
Record" button next to the 
appropriate student. 

3. On the "Forms Menu" click the 
"History" tab. 

4. Find the history page or form that 
you want to view and click on the 
"View" button. 

5. You will then come to a page with 
the form's page(s) listed.  Choose 
the page(s) you want to view and 
click on the "View Selected 
Pages" button. 
 
NOTE: While viewing these 
selected pages you will have an 
opportunity to print or navigate 
back to the page listing, history 
page or forms menu. 
 

6. To delete a history page or form, 
click on the "Delete" button next 
the name of the history you want to delete. 
 
NOTE: Administrators have the option of allowing users to permanently delete history records 
directly or to flag the deleted record for review by the SpEd Forms administrator.  The warning 
that appears when the "Delete" button is clicked should give you an indication of whether the 
record will be "permanently" deleted or you "want the history to be deleted".  If the record is 
not "permanently" deleted, the SpEd Forms administrator will have an opportunity to review 
the record and make the final decision to delete the record or restore it to your list. 

 
2.3.5 Entering student information 
 

1. From the "Main Menu" click on "Work with students". 
2. Click on the "Work on this Record" button next to the appropriate student. 
3. On the "Forms Menu" click on the form in which you wish to work. 
4. Enter the necessary data. 
5. Click "Save" so that your changes are saved to the server. 

 
NOTE: You can navigate through multiple-page forms by clicking the "Forward" button at the top of 
the screen.  Make sure to "Save" your changes before exiting a page. 
 

 18 



2.3.6 Exclusive rights 
 
ER Forms has always had a feature that prevented other users from accessing the same page of a 
particular student's report while you are working on it.  Now, all student forms have this feature. 
 
When you navigate to a form you are given "exclusive rights" to that page for one hour (provided that 
nobody else has already begun working on the same student's form).  As long as you continue to 
"Save" the page at regular intervals within that hour (we recommend saving every 20 minutes), your 
"exclusive rights" will be retained and you can work on that particular page as long as you want. 
 
Information in the navigation bar keeps 
you informed of the status of your 
"exclusive rights".  Five minutes before the 
time that your "exclusive rights" will end, 
a warning with a bright yellow background will 
appear in the navigation bar to inform you that your "exclusive rights" are about to expire.  If you do 
not "Save" the page to retain your rights, that warning will change (at the time of expiration) to inform 
you that your rights have expired.   
 
If a team member/administrator is working on the same student and they navigate to the same form that 
you are working on, they will get a popup that states: 

WARNING: [Your Name] (last login: date/time) 
appears to be already working on this page.  The 
save button has been disabled. 

After the other user clicks "OK", the form will be 
available to them in read only format (no changes can 
be saved) and if they do hit the "Save" button, an 
additional popup warning will be displayed with the same basic information. 
 
NOTE:  If you ignore basic recommendations and wait longer than an hour to "Save" your work, all of 
your changes could be lost if another user begins working on the same page after your "exclusive 
rights" have expired.  Please pay attention to warnings and please take note of the following examples.   

Example 1 
Sally opens section 5 of Johnny's ER at 2:00pm.  She has "exclusive rights" in section 5 until 3:00pm.  
Sally "Saves" her work each time she completes a paragraph and/or completes a few lines of data 
(when the page is "Saved", "exclusive rights" are reset to one hour).  Meanwhile, Kim saves a form that 
she is working on and navigates to section 5 of Johnny's ER at 3:01pm.  Kim is warned that Sally is 
working on that page and navigates to another form until Sally is finished. 

Example 2 
Sally opens section 5 of Johnny's ER at 2:00pm.  She has "exclusive rights" in section 5 until 3:00pm.  
Sally concentrates and continues to work without "saving".  Meanwhile, Kim saves a form that she is 
working on and navigates to section 5 of Johnny's ER at 3:01pm.  Sally's "exclusive rights" have 
expired so that Kim can access the page (unaware that Sally is also working on section 5).  Kim then 
has "exclusive rights" to section 5 until 4:01pm.  At 3:30pm, Sally finishes her work in section 5 and 
clicks the "Save" button.  Since Kim now has "exclusive rights" to section 5, Sally will get a popup 
informing her that:  Kim appears to be working on this page and the save button has been disabled.  
After clicking "OK" the information on Sally's page will revert to whatever Kim has saved or what is 
currently in the database (all of her work, since 2pm, will be lost). 
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2.3.7 Spell check 
 

1. After you have navigated to a form and made changes, click on the button in the SpEd 
Forms navigation bar. 

 
NOTE:  The only fields that will be checked are 
the text fields with a scrollbar on the right side.  
If there are no fields to spell check on this page a 
warning box will popup stating that "There are no 
narrative fields to check". 
 

2. A new window will appear and if a word is 
suspected of being misspelled, it will be shown in 
bold red text.  Suggestions of the correct spelling 
will also be shown. 
 
NOTE:  If you are working on a Spanish page in 
SpEd Forms you can change the dictionary to 
Spanish by choosing "Espanol" from the drop down box next to "Dictionary language". 
 

3. Make sure the correct spelling is highlighted and click on the "Change" or "Change All" button.  
If you want to skip making changes to that word click on "Ignore Once" or "Ignore All" to skip 
all words that are spelled the same. 
 
NOTE:  If none of the suggestions are spelled correctly. click on the misspelled word in the top 
window and make the proper corrections.  Click on the "Change" button to set the correction.  
This word may then be shown as misspelled again in the top window if it is not found in the 
dictionary.  If you want, you can then click on the "Add to Dictionary" button to add that word 
to your personal dictionary. 
 
When the spell check is checking grammatical errors the words will be shown in bold green text 
(or just normal text) and the "Ignore All", "Add to Dictionary", "Change All" and 
"AutoCorrect" buttons will be grayed out (unavailable).  If you do not want to check or correct 
grammatical errors, uncheck the "Check grammar" button (sometimes the spell check can be a 
nuisance by bringing up too many grammar suggestions and single words or number sequences 
from table data).  
 
When misspelled words are being found you can click on the "Options…" button to set some of 
the advanced features.  Click on "Reset Personal Dictionary" to clear out any words you have 
added to the dictionary or click on the "Reset AutoCorrect" to clear the "AutoCorrect" database. 
 

4. Click "Done" to stop.  A summary will then shown for the number of words checked/changed. 
5. Make sure to "Save" the page you are working on after the spell checker has completed. 
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2.3.8 Printing forms 
 
Please make sure to read section 1.1 of this user guide before printing any forms from SpEd Forms. 
 
To print the completed form, make sure that anything you are printing has been saved by clicking 
"Save" from the SpEd Forms screen before printing. 
 

1. Click the "Print" button at the far right of the SpEd Forms navigation bar. 
2. DO NOT use the "Print" command from the "File" menu. 

 
Special instructions: 
 

· PC users can use CTRL + P as a shortcut. 
· Macintosh users will see a "Print Preview" page before the form prints.  After clicking the 

"Print" button in the SpEd Forms navigation bar (as described above) use the browser's File/
Print feature (if a print dialog box does not come up automatically) or use COMMAND (open 
apple) + P as a shortcut. 

 
Printing the entire IEP, IFSP, IIIP, ER: 
 

Users can print all the pages of these 
service plans rather than printing each 
page individually. 
 

1. Navigate to the "Forms Menu" 
of the appropriate student. 

2. Click on one of the service 
plans listed above. 

3. Click the "Print..." button 
(directly under the service plan 
name/student's name). 

4. A new window will appear 
with check boxes next to each 
form page. 

5. Select the pages you want to 
print and click on the "Print 
Selected Pages" button. 
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3. Working with forms 
 
3.1 Creating history pages 
 
Many forms can be stored electronically for future reference.  They include: 
 

· Prior Written Notice / Notice of District's Proposed Action or Denial 
· Notice of Educational Evaluation/Reevaluation Plan 
· Notice of a Team Meeting 
· Agreement Regarding IEP Team Member Attendance 
· All pages of the Evaluation Report 
· All pages of the Individualized Education Program - (IEP) 
· Progress Report (IEP) 
· All pages of the Individualized Family Service Plan (IFSP) 
· All pages of the Individual Interagency Intervention Plan (IIIP) 
· Periodic Review (IIIP) 

 
3.1.1 Creating a history page for a student 
 

1. From the "Forms Menu", navigate 
to one of the pages listed above. 

2. Make sure all information has 
been "Saved" on the pages that are 
going to be finalized. 

3. At the top of each of these pages 
you will notice a "Finalize" button. 

 
 NOTE: If you are creating a 

history from one of the service 
plans (IEP, IFSP or IIIP), you 
must first "Validate" the form.  
When you click the "Validate" 
button, your form pages will be 
checked for required fields and/or inconsistencies.  If an issue is found through the validation 
process, you will be given the opportunity to change those fields before you follow through 
with "Finalization".  Make any changes as needed to satisfy the validation process. 

 
4. Click on the "Finalize" button. 

 
NOTE: Once the "Finalize" button is clicked, a copy is made of that form and can be viewed by 
clicking the "History" tab on the forms menu (see Section 2.3.5 for more information about viewing or 
deleting a student's history).  The current information or "working copy" of the original form is not 
changed. 
 

 22 



3.2 Working with goal pages 
 
The IEP, IFSP and IIIP all have goal and objective pages.  You can fill these goals out with your own 
goals or SpEd Forms has a bank of goals and objectives that can be used to help complete these pages. 
All of the goal pages work in a similar manner so this example can be used to fill out any of the goal 
and objective pages. 
 
This example uses page 4 of the IEP. To get to this page: 
 

1. Navigate to the "Main Menu". 
2. Click on the "Work with Students" button. 
3. Click on "Work on This Record" for the relevant student. 
4. Click on "IEP" (Service Plan) from the "Forms Menu". 
5. Click on page 4. Student Performance (goals). 

 
You are now at the goal page for goal #1, as indicated by the heading on the top left of the form 
("Goal/Outcome [1 ] of 3"). 
 
NOTE: As the number of goal pages 
increases, this heading will change to 
reflect the total number of goal pages. 
The number of goal pages is also 
indicated at the top right of the page. 
The number of pages in the "Go to 
Goal" box will increase as your goal 
pages increase. 
 
Clicking on the goal page number will 
take you to that particular goal. 
 
You can renumber the goal pages by 
simply going to that goal page, 
clicking in the goal number box, 
changing the number, and clicking 
"Save". 
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3.2.1 Entering your own goals 
 

1. Follow the steps from section 3.2 (above) to get to the goal pages. 
2. Select a category from the "Select Category" drop down box. 
3. Enter the "Present Level(s) of Academic and Functional Performance" as needed. 

 
NOTE: This area will appear on every goal page you print. If you do not want it to show on a 
page, do not enter any information in the present levels area. 
 

4. Enter the goal information under "Measurable Annual Goal". 
5. Click the "New Objective" button to enter your objectives. You may add as many objectives as 

you like for each goal. 
 
NOTE: You can reorder your objectives by changing the number in the box to the right of the 
"Objective/Indicator" heading and clicking the "Save" button. 
 

6. Enter "How will progress toward meeting this annual goal be measured?" as needed. 
 
NOTE: Always remember to click the 
"Save" button or the text of your goals & 
objectives will be lost. 
 
3.2.2 Using the goal bank 
 

1. Follow the instructions in section 
3.2  to access the goal pages for a 
student IEP, IFSP or IIIP. 

2. Click on the "Choose Goal" button 
at the top of the page. 

3. In the goal bank search box select 
a category, then a subcategory and 
choose the goal bank you want to 
access from the drop down menus. 

 
NOTE: If you choose "My Goal 
Bank", you will get a listing of the 
goals you have entered into your 
custom goal bank.  From this screen 
you can also manage your custom 
goal bank by using the button in the 
navigation bar (also see section 1.4). 
 
4. Click "Search". 
5. Click on the "Choose Objectives" button under the relevant goal. 
6. Then put a check in the box next to the objectives you want to include with this goal. 
7. Click "Add to goal page". 
 
NOTE: The student's name will be incorporated into the goal and into each objective wherever 
CHLD is used.  You will be able to edit any part of the goal once it has been selected and inserted 
into the goal page. 
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3.2.3 Measure the progress of an objective 
 
While working on the goal pages, the progress of each objective can be followed in detail through preset 
measures.  You can keep track of the student's progress by recording the results of each encounter. 
 

1. Follow the instructions in section 
3.2  to access the goal pages for a 
student IEP, IFSP, or IIIP. 

2. Click on the "Measure Objective" 
link next to the objective you want 
to measure the progress of. 

3. On the "Measure" page select a 
measure from the drop down box, 
enter a score and the date the 
objective is expected to be achieved. 

 
NOTE:  If "No measures are entered" 
you can enter them in the "Measures 
Bank" of "Your Setup" (see section 1.5). 
 
4. Come back to this page as necessary 

and add results by entering the date, 
time and score for each achievement  
and then click the "Add" button. 

5. Click the "Save" button to save your changes. 
 

NOTE: You can "remove" any of the results that have already been added by putting a check in the box 
next to that result or make any other necessary changes and click the "Save" button. 
 
3.2.4 Chart the progress of a measure 
 
When a number of "Results" have been entered for the measure (section 3.2.3) a graph can be created to 
get a detailed visual representation of the 
student's progress through that objective. 
 

1. Follow the instructions in section 
3.2  to access the goal pages for a 
student IEP, IFSP or IIIP. 

2. Click on the "Measure Objective" 
link next to the objective you want 
to measure the progress of. 

3. On the "Measure" page click on the 
"Chart progress" link. 

 
NOTE: In order to "Print" the chart or graph 
you must click on the graph to activate it.  
Then use the "PRINT" button at the top right of the chart. 
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3.3 Services and modifications page 
 
Information about the services provided to students can be collected by the school or district 
administrator.  For this information to be accurate, the services and modifications pages need to be filled 
out in a certain way. 
 
Add a new service 
 

1. While you are "Working with students", in the "Forms Menu", click on "IEP". 
2. In the IEP menu click on "Services and Modifications". 
3. Click the button labeled "Add 

Special Education Services". 
4. A yellow box will appear for your 

service. 
 
Enter information about the service 
provided to the student 
 

1. Select the service you are providing 
from the drop down box or in the 
box labeled "Other" (if available). 
 
Important Note: Whenever 
possible, select the service from 
the list of services provided.  If 
you type a service in the "Other" 
box, the information cannot be 
collected by your billing person 
for the purposes of tuition billing.  
If you need services added to the 
services menu, contact your SpEd 
Forms administrator. 
 

2. Indicate the setting in which the 
service will be provided by entering the "Location" in the general/special education field. 

3. Enter the "Start Date" and "End Date". 
4. Enter, in the "Frequency" field, the number of times the service is to be provided to the student 

for each period (usually "week"). For example if the student receives the service five times a 
week type "5" and select "week". 

5. Enter the number of direct and indirect "Minutes per session". 
6. Indicate the "Anticipated duration" for which the student will receive the service. 
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Indicate service provider 
 
You should indicate the person providing 
this service to this student.  This 
information can be collected by the 
special education director and business 
manager to assist with teacher workload 
analysis and tuition billing. 
 
To indicate the provider of the service, 
click on the "Provider" link.  Then in the 
popup window, click "Select" next to the 
provider's name (names will appear in 
alphabetical order by last name). 
 
Calculating service minutes 
 
SpEd Forms helps you calculate the number of service minutes for each service to be received by the 
student over the course of an IEP.  Your school district may require you to enter the information 
needed to calculate service minutes. 
 

1. Toward the bottom right of each service you will see boxes for the Multiplier & Total Minutes: 

2. In the "Multiplier" box, enter the number of school weeks this IEP is in effect.  This number 
will usually be 35, 36 or 37 depending on the length of your school year.  If the IEP is for part 
of the school year enter the number of school weeks the IEP is in effect. 

3. Click on the "Save" button. 
4. The "Total Minutes" will then be calculated and displayed for the indirect and direct minutes of 

service provided over the course of this IEP. 

Important Note: SpEd Forms calculates the total minutes by multiplying: 
(frequency) x (minutes per session) x (multiplier) 
If your frequency is not "weeks" you will need to adjust your multiplier accordingly.  
 

27  



Fields on the services and modifications page 

Service # 
This number determines the placement of the service on the printed services page.  To re-order 
services, change the numbers in these boxes. 

Active 
Check this box for services you wish to print.  Uncheck for services you wish to keep in SpEd 
Forms for the purposes of tuition billing but are no longer part of the current IEP. 

Instruction or service provided 
A menu appears here with the list of services provided by your district.  Use this menu to select the 
service being provided to the student. 

Provider 
Select the name of the person providing the service from the provider menu. This information is 
used to analyze teacher workloads. 

Location 
Enter "X" in either the General Education or Special Education box to indicate where the service is 
being provided.  You may also type the actual location of the service (eg: room number). 

Start date 
Enter the date on which this service commences. 

End date  
Enter the date on which this service ends.  This data does not print but is collected on your school 
services report. 

Frequency 
Enter a number in the left field and select an option from the menu to the right.  The anticipated 
frequency records the number of times the service will be provided per time period.  In most cases 
the period will be "week". 

Minutes per session 
Enter the number of Indirect and Direct service minutes provided to this student. 

Anticipated duration 
Enter a number in the left field and select an option from the menu to the right. 

Multiplier 
This number is used to calculate the total number of minutes being provided to the student.  This 
number is multiplied by the frequency and number of minutes to calculate totals. 

The following examples are assuming a frequency of "(x) weeks". 
#1:  A service is provided for an entire school year (36 weeks).  Put 36 in the "Multiplier" box. 
#2:  This service is provided for only part of the school year.  The number of weeks being provided 
is 12.  Enter 12 in the "Multiplier" box. 
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3.4 The progress report 
 
When you first open the IEP progress report, the "Goal" and "Comments" sections will be 
automatically populated with the student's current annual instructional goals and objectives. 
 
3.4.1 Adding additional comments to existing goals 
 

1. Type in additional comments or 
make any changes as needed. 

2. Click "Save" so that your changes 
are saved to the server. 

 
NOTE:  Saving changes to goals in the 
progress report will not effect goals on the 
student's goal page. 
 
3.4.2 Clear/Refresh progress report 
(case managers only) 
 
NOTE:  This button only appears for the 
student's case manager or administrators. 
 
If changes have been made on the 
student's goal page or goals have been 
cleared out in preparation for the coming 
semester and you would like those 
changes to appear in the progress report. 
 

1. Click on the "Clear/Refresh 
Progress Report" button. 

2. Click "Save" so that these changes are saved to the server. 
 
CAUTION: Clicking on the "Clear/Refresh Progress Report" button will erase any additional 
comments or changes you have made to the progress report and will import the current goals 
and objectives that have been most recently saved on the student's goal page. 
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3.5 Reports 
 
Teachers and administrators rely on reports to give them complete and reliable information.  Without 
knowing how these reports work, it may be difficult to know what information is needed for these 
reports to work properly. 
 
NOTE: An important thing to remember 
is that several of the reports for teachers 
and administrators alike use specific data 
from other SpEd Forms pages to 
determine what students show up on the 
report. 
 
3.5.1 Combined report 
 

1. Navigate to the "Main Menu". 
2. Click on the "Reports" button. 
3. Click on the "Combined report". 
4. Choose the IEP manager or 

service provider option & pick the 
"Order By" criteria (if necessary). 

 
NOTE: If you choose "IEP Manager", all 
the students that you are IEP manager for will be shown on this report.  If you are the service provider 
you may not have any students that are assigned to you but when you choose "Service Provider", the 
accompanying report will reveal any students where you are the provider for at least one service.  The 
service provider's ID is indicated in the "Provider" field that is located on each service and available on 
any service page (see the explanation of "Indicate service provider" in section 3.3 for more 
information). 
 
3.5.2 Teacher workload analysis 
 

1. Navigate to the "Main Menu". 
2. Click on the "Reports" button. 
3. Click on the "Teacher workload 

analysis". 
4. Fill in the number of evaluations 

and re-evaluations (if necessary) 
and click on the "Save" button. 

 
NOTE: The "Teacher Workload Analysis" report is directly related to the service provider's ID in the 
"Provider" field that is located on each service and available on any service page (see the explanation 
of "Indicate service provider" in section 3.3 for more information). 
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5. Getting started in ER Forms 
 
PLEASE NOTE: If ER Forms is installed for your district, "with ER Forms!" will be shown in red next 
to the evaluation report on the forms menu.  Before you start using ER Forms you must ensure your 
computer is setup correctly.  Please see "Configuring Your Computer" (section 1.1 of this guide) if you 
have not already done so. 
 
Overview of editing modes 
 
There are two completely different editing 
modes that can be used when editing text 
in the various sections of ER Forms.  The 
original way of using simple text editing 
commands has been the standard for 
several years.  This involves the use of 
carriage returns (using the "enter" key) 
and spaces along with a fixed-width font 
(Courier) to line-up text and tables much 
like you would while using a simple text 
editor like Notepad, SimpleText or 
TextEdit.  A new editing feature has been 
added to ER Forms where buttons can be 
clicked to modify the text including bold, 
italic, underline, alignment, indentation 
and the insertion of tables.  This robust 
editing feature has been made available 
through specific web browsers by a 
technology called DesignMode.  In most 
cases DesignMode has been made the 
default mode of editing in ER Forms. 
 
If your SpEd Forms administrator has allowed the use of "Text Mode", you will see an option in "Your 
Setup (Profile)" that you can use to choose whether DesignMode is on or off by default (see section 1.3 
for more information).  You will also have an opportunity to choose either editing mode when you 
begin a new evaluation report (when choosing a new template, check/uncheck the "DesignMode" 
checkbox before choosing the local/SpEd Forms template. 
 
Important Note:  Once you start an evaluation report, you must complete it using the same mode. 
 
DesignMode requirements 
 
To use the DesignMode editing features, you must have at least Internet Explorer 6, Opera 9 or Firefox. 
Please make sure you are using a compatible and updated browser (some earlier Windows versions of Firefox/
Mozilla/Netscape had been reported to drop the spaces between words after saving in DesignMode). 
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5.1 Choosing your first template 
 

1. Navigate to the "Forms Menu" for the student you wish to work on. 
2. Click on the "Evaluation Report" link toward the top of the "Forms Menu". 
3. A message will appear asking if you would like to select a template for your evaluation report. 

There are two types of templates (besides a "blank" report) available for you to choose from. 
 

· Local District Templates: These are templates created by your school district or cooperative, 
for your use. 

· SpEd Forms Templates: Generic templates for each of the major disability areas used 
statewide. 

 
NOTE: If this student already has 
a template, you can choose a new 
template by clicking the "Choose a 
New Evaluation Template" button 
on the bottom of the menu page.  
If you follow through with 
choosing a new template, your 
existing template will be 
overwritten.  See section 7 for 
additional instructions on how to 
"Select a Template". 
 

4. To start with a "Text Mode" template make sure "DesignMode" is NOT checked (if available). 
 
NOTE: DesignMode templates are specially formatted to work with the features of 
DesignMode.  If you choose not to use DesignMode templates, you must use the original basic 
rules to edit the sections of your evaluation report. 
 

5. If you choose "Blank Evaluation 
Report" you will be taken directly 
to the evaluation report menu.  If 
you chose "Local District 
Template" or "SpEd Forms 
Template", a list of templates will 
appear.  Click on the "Preview" 
button next to the template you 
wish to view. 

6. A preview of the template you 
selected will be shown.  If this is 
the template you want to use for 
your evaluation report click 
"Select This Template", otherwise 
click "Select Another Template" to 
view another. 

7. The template will be automatically entered into the evaluation report and you will be taken to 
the evaluation report menu. 
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6. The evaluation report menu 
 
The evaluation report is separated into twelve areas.  Student information, sections 1 to 10 and the 
signature page. 
 
6.1 Determining if DesignMode or Text Mode is being used for this report 
 

1. You can determine if DesignMode is ON or OFF by looking at the "DesignMode" button.  The 
button will show a green (ON) box if DesignMode is active and a red (OFF) box if 
DesignMode is inactive. 

 
Important Note:  Once you start an evaluation report, you must complete it using the same mode. 
 
6.2 Navigating to different sections of the evaluation report 
  

1. To navigate, simply click on the name of the area you wish to work on. 
 

· Student information: Replicates the first page of the state recommended evaluation report.  
NOTE: If you entered an evaluation report prior to installing ER Forms, you can view it on 
this page. 

· Sections 1 to 10: This is where 
you write the bulk of your 
evaluation report.  Each 
section expands up to 
1,000,000 characters or about 
100 typed pages (Internet 
Explorer on the Mac is limited 
to 32,000 characters or 4-5 
typed pages for each section).  
When the entire evaluation 
report is printed, all sections 
(including the student 
information page, sections 1 
through 10 and the signature 
page) can be printed together 
as one report (see section 13 
for more information about 
printing the entire evaluation report). 

· Signatures page: Replicates the last page of the state recommended evaluation report.  
Attach this page to your evaluation report. 

 
NOTE: If this student already has a template you can choose a new template by clicking the 
"Choose a New Evaluation Template" button on the bottom of the menu page.  If you follow 
through with choosing a new template, your existing template will be overwritten.  See 
section 7 for additional instructions on how to "Select a Template". 
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7. Select a template 
 
SpEd Forms contains templates for each major disability area.  Your school district may also create 
custom templates for your use. 
 
7.1 Selecting a new template 
 

1. Navigate to the ER Forms menu. 
2. Click on the "Choose a New 

Evaluation Template" button at the 
bottom of the ER Forms menu. 

3. At the next screen choose the type 
of template by clicking on the 
"Local District Template", "SpEd 
Forms Template", "Blank ER 
Template" or "Cancel" to go back 
to the ER Forms menu.  Uncheck 
DesignMode (if available) to 
choose the original "Text Mode". 

 
WARNING : If you "Choose a New Template" the student's existing evaluation report will 
be overwritten. 

 
4. If you "Choose a New Template" 

you will be redirected to the 
template server and a list of 
templates will appear.  Click on 
the "Preview" button next to the 
template you wish to select. 

5. A preview of the template you 
selected will be shown (the 
template will be formatted in 
DesignMode unless your 
administrator has allowed you to 
unchecked DesignMode).  If this 
is the template you want to use for 
your evaluation report click 
"Select This Template", otherwise 
click "Select Another Template" to 
choose another. 

6. The template will be automatically 
entered into the evaluation report 
and you will be taken to the 
evaluation report menu. 
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8. The student information page 
 
The student information page replicates the first page of state recommended evaluation report. 
Demographic information is automatically transferred if it has been entered elsewhere in SpEd Forms. 
 
8.1 Editing the student information page 
 

1. To open the "Student 
Information" page navigate 
to the ER Forms menu. 

2. Click on the "Student 
Information" link.  The 
student information page will 
appear. 

 
NOTE: If you had entered an 
evaluation report before ER 
Forms was installed on your 
server there will be a button 
available at the bottom of this 
page that you can click on to 
show your prior report.  The 
text that is displayed here is 
provided for your convenience and 
if it is your current evaluation 
report, you should copy and paste 
this information into any of the 
other sections (1-10) of the 
evaluation report.  You must click 
on the "Show pre-ER Forms 
Evaluation Report" button each 
time you navigate to this page to 
display the text (if this is from an old evaluation report, please disregard this feature, it will not 
be printed when you print the evaluation report). 

 
3. Edit the demographic information where necessary. 
4. Click the "Save" button to save the changes on your SpEd Forms server. 
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Remember to SAVE often.  

We recommend that you  

SAVE every 20 minutes. 

Please see section 2.3.6 for more details 
concerning saving & exclusive rights. 



9. Sections 1 to 10 
 
The evaluation report is broken into ten sections to help you organize your report and to provide as 
much space as possible.  Each section will hold upwards of 100 printed pages of typed information 
(using Internet Explorer on the Mac will limit space to 4-5 typed pages for each section).  When the 
entire evaluation report is printed, all sections (including the student information page, sections 1 
through 10 and the signature page) can be printed together as one report (see section 13 for more 
information about printing the entire evaluation report).  If you used a template for your evaluation 
report, your evaluation report will be automatically organized into sections. 
 
9.1 Editing a section using the original Text Mode (DesignMode users see section 9.2) 
 

1. On the ER Forms menu there 
is a link to each of the ten 
sections.  Click on the section 
that you wish to work on. 

2. You may, if you wish, replace 
the existing title of that page 
with your own.  When your 
evaluation report is printed, 
the title will appear above this 
section in bold type. 

3. Type information for this 
section in the large text box 
towards the bottom of the 
screen.  You will be able to 
type over 1,000,000 
characters (using Internet 
Explorer on the Mac will limit 
space to 32,000 characters) into 
each of the large text boxes in 
each section.  When printed, the 
box will expand automatically to show all you have typed. 
NOTE: Be aware of text formatting issues (section 14 of this guide). 

4. Click on the "Save" button to save the changes on your SpEd Forms server. 
5. The "Back" and "Forward" buttons allow you to navigate to the next and previous sections. 

 

Remember to SAVE often.  

We recommend that you  

SAVE every 20 minutes. 

Please see section 2.3.6 for more details 
concerning saving & exclusive rights. 
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9.2 Editing a section using DesignMode (see section 9.1 if you're using the original Text Mode) 
Section 5 has more information about DesignMode (including an overview & system requirements). 
 

1. On the ER Forms menu there 
is a link to each of the ten 
sections.  Click on the section 
that you wish to work on. 

2. Changing the "Menu Title" 
will only change the title that 
appears on the menu page.  
The title of this section is 
included in the large text box 
so that you can edit the text 
with the DesignMode 
features. 

3. Type information for this 
section in the large text box 
towards the bottom of the 
screen.  You will be able to 
type over 1,000,000 characters 
(using Internet Explorer on the Mac 
will limit space to 32,000 
characters) into each of the large 
text boxes in each section.  When 
printed, the box will expand 
automatically to show all you have typed.  NOTE: Be aware of 
text formatting issues (section 14 of this guide).  Use the following instructions for enhancing 
text in the DesignMode window of your ER Forms document. 

Font Style - highlight any word or combination of words then select a "Font Style" from the list. 
Font Size - highlight any word or combination of words then select a "Font Size" from the list. 
Italic - highlight any word or combination of words then click the "italic" button. 
Italic - highlight any word or combination of words then click the "italic" button. 
Underline - highlight any word or combination of words then click the "underline" button. 
Align-Left - with your cursor in a paragraph or table, click to align text to the "left". 
Align-Center - with your cursor in a paragraph or table, click to center align text to the "center". 
Align-Right - with your cursor in a paragraph or table, click to align text to the "right". 
Indent - with your cursor in a paragraph or table, click to increase the "indent". 
Outdent - with your cursor in a paragraph or table, click to decrease the "indent". 
Undo - use this button to "undo" your previous change. 
Redo - use this button to "redo" changes that you have undone using the "undo" button. 
Table - click on the "table" button to insert a table in your document.  After clicking the table 
button a new window will popup allowing you to set conditions for the table (including its size 
and appearance).  NOTE: You can use a border thickness of "0" to make the table invisible. 
Single Line Spacing (windows users only) - using the "enter" key by itself will put a large space 
between paragraphs.  Hold down the "shift" key while you hit "enter" for single line spacing. 

4. Click on the "Save" button to save the changes on your SpEd Forms server. 
5. The "Back" and "Forward" buttons allow you to navigate to the next and previous sections. 
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10. Copy a test 
 
ER Forms includes a data bank of more than 100 commonly used educational tests that can be copied 
into your evaluation report.  Your school district or service cooperative can also add tests. 
 
10.1 Select a test from the test templates 
 
To copy a test, first navigate to the section in which you wish the test to appear. 
 

1. You may copy tests from the SpEd 
Forms test bank or the local 
district test bank.  Click on the 
"Tests" button. 

2. You will be redirected to the 
template server.  Select the 
category of test you are interested 
in from the menu and then click on 
the "View Tests" button. 

3. A list of available tests in that 
category will appear.  Click on the 
"Preview" button next to the test 
you wish to copy to your 
evaluation report. 
 
NOTE: If your template is in 
DesignMode, only tests that are 
formatted for DesignMode will be 
shown and if you are using the 
original Text Mode, tests will be 
shown that are formatted in this 
mode. 
 

4. You will be shown a preview of 
the test that you selected.  Click on 
"Select Another Test" if you want 
to preview another test or click on 
the "Select This Test" button to 
add this test to your evaluation 
report.  A message will appear alerting you that the test has been copied to your page. 
 
NOTE:  If you are using DesignMode, your test will be inserted into the section of your report 
at the point where you cursor was located.  In the original Text Mode the test is automatically 
copied to the end of the page that you are working on (if you do not see the test, scroll down to 
the bottom of the text field in the lower half of your screen). 
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11. Copy criteria 
 
ER Forms includes a data bank of criteria for each disability.  Your school district or service 
cooperative can also add criteria. 
 
11.1 Select criteria from the criteria templates 
 
To copy criteria, first navigate to the section in which you wish the criteria to appear. 
 

1. You may copy criteria from the 
SpEd Forms criteria bank or the 
local district criteria bank.  Click 
on the "Criteria" button. 

2. You will be redirected to the 
template server.  A list of available 
criteria will appear.  Click on the 
"Preview" button next to the 
criteria you wish to copy to your 
evaluation report. 
 
NOTE: If your template is in 
DesignMode, only criteria that is 
formatted for DesignMode will be 
shown and if you are using the 
original Text Mode, criteria will 
be shown that is formatted in this 
mode. 
 

3. You will be shown a preview of 
the criteria that you selected.  
Click on "Select Another Criteria" 
if you want to preview other 
criteria or click on the "Select This 
Criteria" button to add this criteria 
to your evaluation report.  A 
message will appear alerting you that the criteria has been copied to your page. 

 
NOTE:  If you are using DesignMode, your criteria will be inserted into the section of your 
report at the point where you cursor was located.  In the original Text Mode the criteria is 
automatically copied to the end of the page that you are working on (if you do not see the test, 
scroll down to the bottom of the text field in the lower half of your screen). 
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12. The signatures page 
 
The signatures page replicates the last 
page of the state recommended evaluation 
report.  If you entered information into the 
old evaluation report in SpEd Forms 
Internet Edition, it will automatically be 
transferred here. 
 
12.1 Editing the signatures page 
 

1. To open the signatures page, 
navigate to the ER Forms menu.  
Click on the "Signature Page 
(Print and Attach)" link. 

2. The signatures page will appear.  
Edit the information where 
necessary. 

3. Click the "Save" button to save 
your changes on the SpEd Forms 
server. 

4. Attach this page to your evaluation 
report. 

 
NOTE:  When the entire evaluation report 
is printed you will have an opportunity to 
include the signature page (see section 13 
for more information about printing the 
entire evaluation report). 
 

 40 



13. Printing the evaluation report 
 
13.1  Printing the whole report 
 

1. Navigate to the ER Forms 
menu.  Click on the "Print 
Preview" button. 

2. A new window will appear 
with check boxes next to each 
page. 

3. Select the pages you want to 
print and click on the "Print 
Selected Pages" button. 

 
13.2  My ER prints off the page! 
 

1. If your ER goes off the side of 
the page when you print or it 
is very wide when viewed in the 
"Print Preview" window, you may 
have extraneous characters or spaces 
in your document. 

2. Select "Edit" and click on "Select All".  This will highlight all of the text in your document. 
3. Scroll down until you find a 

highlighted area that goes all 
the way across the page, then 
take note of what section it is 
in and close the "Print 
Preview" window (you cannot 
make edit changes in the "Print 
Preview" window). 

4. Open the appropriate section, 
replace whole lines with 
carriage returns and make any 
other pertinent corrections. 
Hint:  You can click 
anywhere in the text box and 
use the "Select All" feature 
to highlight all of the text. 

5.  "Save" this section and open 
"Print Preview" again as 
described in section 13.1  
(Repeat these steps if you  
need to make additional 
corrections). 
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14. Text formatting issues 
 
Keep in mind that while you type and layout text in the text boxes provided to make your evaluation 
report, even with the robust features of "DesignMode", this is by no means a full fledged "Word 
Processor".  There are also specific text formatting issues that come into play when you cut/copy and 
paste text from another "Word Processor". 
 
14.1  Lining up text or information in a table 
 

1. While using the original Text Mode editing features of ER Forms, please use the spacebar to 
line up text or information in a table.  DesignMode users can insert tables to organize blocks of 
text.  The "Tab" key is used (by the web browser) to move between text fields and you will not 
be able to type a "Tab" into any text field on a web browser. 

 
14.2  "Cut/Copy & Pasting" text from another program into the DesignMode window 
 

1. If you "Cut/Copy & Paste" text from another program that has "Tabs" formatted into the text, 
they will be converted to spaces in the DesignMode window.  It might be more desirable to 
create a table in ER Forms and copy the elements to this table. 

 
14.3  "Cut/Copy & Pasting" text from another program into the original Text Mode window 
 

1. If you "Cut/Copy & Paste" text 
from another program that has 
"Tabs" formatted into the text, 
they will show up on the screen 
but will not print.  You can tell if 
there are "Tabs" in your text by 
placing your cursor in a line of 
text and using the arrow keys on 
your keyboard to move back and 
forth.  If the cursor jumps a long 
distance with one move of the 
arrow key, you may have "Tab" 
characters in your document.  
Delete any "Tabs" and use the 
spacebar to line up the columns. 

 
NOTE: If your document looks fine on screen but the columns are not lined up when you print,  
there are probably "Tab" characters in your document. 
 

2. Fonts are converted to "Courier " (a fixed-width font) when pasted into the SpEd Forms 
evaluation report.  This is intentional, so that every character remains the same width (an "i " 
will take up the same space as an "m"). 

3. Occasionally your web browser may not translate special characters correctly when "Pasted" 
from specific operating systems or specific programs.  Smart quotes ( “  ”  ) or ( ‘  ’  ) may cause 
unexpected behavior in some situations.  Try changing them to straight quotes ( "  ) or ( ' ). 
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15.  Getting started in MA Forms 
 
PLEASE NOTE:  Before you start using MA Forms you must ensure your computer is setup correctly.  
Please see "Configuring your computer" (section 1.1 of this guide) if you have not already done so. 
 
15.1 Accessing the MA Forms menu 
 
As soon as MA Forms is installed on your 
SpEd Forms server, it can be accessed by 
clicking on the "MA Forms" tab toward 
the top of the "Forms Menu". 
 

1. Navigate to the "Forms Menu" for 
the student you wish to work on. 

2. In the row of yellow tabs toward 
the top of the "Forms Menu" click 
on "MA Forms". 

3. The MA Forms menu will then 
appear. 

 
15.2 Student billing setup 
 

1. Navigate to the MA Forms menu. 
2. Click on "MA Billing Setup". 
3. Fill in as much of the billing 

information as you can for this 
student. 

 
NOTE: Fields shown in red are 
important for third party billing.  
You can continue to use MA 
Forms if some of this information 
is missing but the MA billing 
administrator cannot bill for 
services until all of the required 
information has been completed. 

 
4. Click on the "Save" button to save 

your changes and navigate back to 
the MA Forms menu by clicking 
on the "Form Menu" button. 
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16.  Entering MA billing information 
 
16.1 Working with activity logs 
 

1. Navigate to the MA Forms menu. 
2. Click on the "Activity Logs" link. 

 
NOTE:  The activity log menu shows no 
more than 12 logs by default.  You can 
change this number and then hit "Enter"  
but it will default back to 12 when you 
quit and login to SpEd Forms again. 
 
16.1.1 Create a new activity log 
 

1. Navigate to the MA Forms menu. 
2. Click on "Activity Logs". 
3. On the activity log menu, click on 

the "New Activity Log" button. 
4. You are then taken to a new IEP/

IFSP services activity log sheet. 
5. Select the "Type of Service provided" and then click on the "Add Activity" button. 
6. Change the "Date of Service" to the actual date the service was provided, fill in the time spent, 

the number of children that were in the group and type in a description or choose one from the 
descriptions drop down list.  When the "Mark as Not Billable" box is checked that service will 
not show up on the MA Billing Administrator's list of (reimbursable) services. 
 
NOTE: You can duplicate any number of activity lines by typing in a number in the "Duplicate 
for (number of days)" box and clicking on the "Duplicate" button (if this box is left blank only 
one log will be duplicated). You can delete activity lines, at any time before they are billed, by 
clicking on the "Delete" button next to the log you want to delete. 
 

8. Fill in your name and title or the name and title of the person fulfilling this service. 
9. Click on "Save" when you are finished and this log will show up on the activity logs menu. 

 
NOTE:  Use the "Finalize" button at the top of the page to render the log as finalized or completed.  
Some districts take this into account when they are building a batch of (only) "Completed" claims.  If 
you need to make changes to the finalized log click on the "Reactivate log" button to reactivate it.   
 
16.1.2 View/Delete existing activity logs 
 

1. Navigate to the "Activity Logs" menu (section 16.1). 
2. Click on "View" next to the log you want to view. 
3. Click on "Delete" next to the log you want to delete. 

 
16.1.3 Duplicate existing activity logs 
 

1. Navigate to the "Activity Logs" menu (section 16.1). 
2. Click on "Duplicate" button next to the log you want to duplicate. 
3. A duplicate log will appear with today's date as the "Log Date".  Make changes as needed. 
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16.2 Working with trip logs 
 

1. Navigate to the MA Forms menu. 
2. Click on the "Trip Logs" link. 

 
NOTE:  The trip log menu shows no more than 12 logs by default.  You can change this number and 
then hit "Enter"  but it will default back to 12 when you quit and login to SpEd Forms again. 
 
16.2.1 Create a new trip log 
 

1. Navigate to the MA Forms menu. 
2. Click on "Trip Logs". 
3. On the trip log menu, click on the 

"New Trip Log" button. 
4. You are then taken to a new IEP/

IFSP services trip log sheet. 
5. Click the "Add Trip" button. 
6. Change the "Date of Service" to 

the actual date the service was 
provided and in the "Miles from 
pick-up to drop-off " for each trip. 
 
NOTE: You can duplicate any 
number of trip lines by typing in a 
number in the "Duplicate for 
(number of days)" box and 
clicking on the "Duplicate" button 
(if this box is left blank only 
one log will be duplicated). To duplicate one log, click the 
"+" button next to the log you want to duplicate or you can delete any of the trip lines, at any 
time before they are billed, by clicking the "-" button next to the log you want to delete. 
 

7. Fill in your name or the name of the person responsible for completing this service. 
8. Click on "Save" when you are finished and this log will show up on the trip logs menu. 

 
16.2.2 View/Delete existing trip logs 
 

1. Navigate to the "Trip Logs" menu (section 16.2). 
2. Click on "View" next to the log you want to view. 
3. Click on "Delete" next to the log you want to delete. 
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16.3 Entering form information 
 

1. Navigate to the MA Forms menu. 
2. Click on the form in which you 

wish to work. 
3. Enter the necessary data. 
4. Click "Save" so that your changes 

are saved to the server. 
 

NOTE:  If a form has multiple pages, 
you can navigate through the pages by 
clicking the "Forward" and "Back" 
buttons in the SpEd Forms navigation 
bar.  Make sure to hit "Save" before 
exiting a page. 
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17. Frequently Asked Questions 
 
17.1 General questions 
 

1. Am I automatically disconnected from SpEd Forms after a certain period of time? 
SpEd Forms will persist your connection for up to 24 hours.  However, we recommend that you 
save your work at least every 20 minutes, especially when working on a dial-up internet 
connection. 
 

2. A message appears saying that the "Page cannot be displayed". What's wrong? 
This is a general message displayed by Internet Explorer when your computer cannot connect to the 
server.  

1. Check your internet connection.  If your internet connection has been disconnected, this 
message will be displayed. 

2. Check to make sure you have correctly followed the Setup procedures outlined on Section 1.1 
of the User Guide.  (This message may be an indication that your page caching setting is incorrect.) 

3. If you continue to get this message please contact your SpEd Forms Administrator. 
 

3. How do I make a backup of my student information? 
Your student information is stored on your school district's SpEd Forms server.  Your SpEd Forms 
server administrator should make a daily backup of the data stored on your SpEd Forms server. 
 

4. I'm using Mac OS X, what browser works best with the features of SpEd Forms? (Mac Only) 
We recommend using Firefox2.  If you are using Opera, it works fine.  For a comparison of how 
some of the more common Mac web browsers work with the features of SpEd Forms, refer to our 
Mac Test Results page at:  http://www.spedforms.com/support/mac_test_results.htm 
 

5. Two students appear to have their information mixed up.  How did this happen? 
SpEd Forms remembers which student you are working on.  The behavior described can occur for 
two reasons: 

1. If somebody else logs into SpEd Forms using your user name and password, then SpEd Forms 
may confuse the student you are working on with the student the other person is working on.  
Never share you user name and password. 

2. If you work on two computers and do not "Quit" SpEd Forms before moving to the second 
computer, SpEd Forms may confuse the students you are working on.  Always "Quit" SpEd 
Forms before moving to a new machine. 
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6. Erroneous information is automatically entered into my forms. How do I turn off "Autofill"? 
When "Autofill" is turned on, the computer tries to automatically fill out forms.  This can cause 
strange things to happen. 

PC Users (Internet Explorer) 
1. Select "Internet Options" from the "Tools" menu. 
2. Click the "Content" tab then click on the "Autocomplete" button. 
3. Uncheck "Forms" and "User names and passwords on forms". 
4. In the "General" tab, click on "Delete…" (browsing history) and "Delete forms/passwords".  

Mac Users (Firefox2) 
1. Select "Preferences..." from the "Firefox" menu. 
2. Choose the "Privacy" tab and uncheck "Remember what I enter in forms and the...". 
3. Choose the "Security" tab and uncheck "Remember passwords for sites". 
4. Click on "Show Passwords..." then click on the "Remove All" button. 

Mac Users (Opera) 
1. Select "Preferences..." from the "Opera" menu. 
2. Choose the "Wand" tab and uncheck "Let the Wand remember passwords". 
3. Clear out any (auto-complete) data then click on "Passwords" and delete all wand logins. 

 
7. When I'm using ER Forms a message appears stating: "This page contains both secure and 

nonsecure items.  Do you want to display the nonsecure items?" (PC Only) 
This message may appear if you have not completed the new setup instructions for DesignMode.  
The following instructions will also appear in section 1.1.1 of the SpEd Forms user guide. 

1. Open Internet Explorer and select "Internet Options" from the "Tools" menu. 
2. Select the "Security" tab and click on the "Custom Level..." button. 
3. In the "Miscellaneous" section - enable "Display Mixed Content" (When you click "OK" 

you will be asked if you want to change the security settings. This is to prevent the warning 
box from being displayed in "Design Mode", it has nothing to do with the security of your 
computer). 

 
8. A "debugging" window keeps coming up.  Is this an error with SpEd Forms? (PC Only) 

You can Disable Script Debugging in Internet Explorer's setup options. 
1. Select "Internet Options" from the "Tools" menu and choose the "Advanced" tab. 
2. In the "Browsing" section put a check in both "Disable Script Debugging" boxes. 
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17.2 Working with student information 
 

9. I cannot add a new student, I get a message saying the student already exists! 
The Student ID number is used extensively throughout SpEd Forms.  A student cannot be added if 
the Student ID you are using for the new student already exists.  There are several reasons why a 
student may already exist in the system. 

1. This student may already have been added by another IEP Manager. 
2. This student is inactive.  Activate the student. 
3. Students that had been deleted by an IEP Manager prior to 1/1/06 will still be in the system 

and need to be reassigned by the Administrator. 
NOTE: Contact your SpEd Forms administrator, they can search for the Student ID number you are 
using and determine if the student already exists in the system. 
 

10. A student does not show up in my list. I'm sure they are assigned to me. Where are they? 
Solution 1:  The student may not be assigned to the same school district as the teacher. 

To show the student:  Click on the "Work with students" button.  In the drop down box above the 
list of students select "Students served by all districts". 
NOTE: To facilitate better organization of students for teachers working in multiple districts, 
students are now organized by school district in the teacher student list. 

Solution 2:  The student evaluation status is not a current special education evaluation status. 
To show the student:  Click on the "Work with students" button.  A list of active students will 
appear. Put a check in the "Show inactive/exited students" checkbox. 
NOTE: If the student does not show up automatically in the teacher list, the student does not have 
a current MARSS Evaluation Status.  The teacher should correct this issue by changing the 
evaluation status for the student to a current evaluation status.  SpEd Forms now keeps a history 
of all evaluation status changes for future reference. 

 
11. Can I change a Student ID on my own, or should I call my SpEd Forms administrator? 

If you are the Case Manager for this student or have been given Edit Access you can change the 
student number.  If you navigate to the "Work with students" list you can edit their number if the 
button states "Work on this Record" but not if it states "View this Record".  To change the number:  

1. From the "Work with students" list click on "Work on this Record" for the intended student. 
2. On the "Forms Menu" click on the "Edit Setup" button. 
3. Next to the Student/MARSS ID click the "Edit" link. 
4. Change the number, as needed, and click "Save". 

NOTE: If you would prefer, you can contact your SpEd Forms administrator and they can do it for 
you as well. 
 

12. How do I change the IEP manager for a student? 
The current IEP Manager is able to reassign the student to a new IEP Manager. 

1. Navigate to the student's "Forms Menu", click on "Student Sharing" and then the "Send this 
student to a new case manager" button. 

2. Select the new IEP Manager from the drop down list and click "Send" (put a check in the 
"Reset current student sharing" checkbox if you no longer need access to this student, if you 
leave it unchecked you will continue to have edit access to this student). 

NOTE: If you are sending this student to a remote manager (not on the same server), fill in the 
information on the bottom of this page, click on the "Create Fax" button and fax it to the new IEP 
Manager. 
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13. When I enter information in a form, then come back later, it is gone. What happened? 
The changes you have made to one of your forms could be lost for any of the following reasons: 

1. You may not have clicked the "Save" button after you had finished entering information.  After 
you have finished making changes to ANY page, you must click the "Save" button to save 
your changes to the SpEd Forms server. 

2. If somebody else logs into SpEd Forms using your user name and password, then SpEd Forms 
may confuse the student you are working on with the student the other person is working on.  
Never share you user name and password. 

3. If you work on two computers and do not "Quit" SpEd Forms before moving to the second 
computer, SpEd Forms may confuse the students you are working on.  Always quit SpEd 
Forms with the "Quit" button on the navigation bar before moving to a new machine. 

 
14. Why does the Spell Check find numbers and then only lets me ignore them one by one? 

If the Spell Check only allows you to "Ignore Once" and/or the errors are shown in bold green text 
the Spell Check is checking for grammar.  You can uncheck the "Check grammar" checkbox. 
 

15. Sometimes I enter a date and it does not save. Why not? 
If you do not enter a valid date your date will not be saved.  The date format is MM/DD/YYYY.  If 
you enter any non-numeric characters in a date field it also will not be saved. 
 

16. Why are some names on my caseload not showing up on the Combined Report? 
It may be because not all the proper fields are completed.  In order for a record to appear on this 
report, you must have both a team meeting date and a primary disability entered into the system. 
 

17. How do I exit a student from my caseload? 
Only those with edit access to the student can exit them from special education.  To exit a student:  

1. From the "Work with students" list click on "Work on this Record" for the intended student. 
2. On the "Forms Menu" click on the "Edit Setup" button. 
3. Next to "Evaluation Status", select code 2, 5 or 7 and/or for the "Status End (Exit Reason)", 

select a code prefaced by the word "EXIT". 
4. Enter any other pertinent information and click "Save". 

NOTE: Once a student is exited they will no longer be listed on the teacher's list.  Contact the SpEd 
Forms administrator to reassign a student that has been exited. 
 

18. Can the IEP be "archived" so that you can keep last year's IEP and make a new one too? 
Teachers can click on the "Validate" button on the IEP menu, make any necessary changes and then 
click on the "Finalize" button.  A History will then be made of all IEP pages.  From the Forms 
Menu, click on the "History" tab to view any history pages that have been made for that student. 
 

19. How do I change the goals from last year to make them current for this year? 
Simply delete the old goals and then enter the new information for this year. 
 

20. How do I re-number Goals? 
On each goal page you are able to type a new number in the Goal Number box.  After you change 
the number click "Save" and the goals will be reordered. 
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21. Some tips for entering information into ER Forms: 
The default print margins for SpEd Forms are 0.5 inch.  This is because most of the state due 
process forms do not fit on a page with large margins.  You can change the print margins by 
selecting Page Setup from the File Menu.  If you do change the print margins for the Evaluation 
Report, don't forget to change them back when you print an IEP. 
 
If you paste text in from another document or Word Processing program make sure all of the 
special formatting has been omitted.  Most of these Word Processing programs can save the 
document in "plain text" format or you can use a simple program like Notepad (PC) or TextEdit 
(Mac, under "Format" select "Make Plain Text").  Use the tips listed below to add formatting back 
into the document. 
 

DesignMode 
1. Type up whole paragraphs of text and then go back and highlight the areas you want to 

enhance (bold, italic, underline), otherwise it can become difficult to stop or undo these 
specific enhancements as you type.  The alignment or indent buttons effect the whole 
paragraph where the cursor is located (not limited to the highlighted text). 

2. When adding tables from scratch, put some thought into how many rows and columns you 
will need (you cannot alter the table after it has been created).  In most browsers you can 
click on the outer perimeter of the table and then hit the delete button to delete it. 

3. Tests and/or Criteria are imported at the point where the cursor is located (not at the bottom 
of the page as in Text Mode). 

 
Original Text Mode 

1. Use spaces rather than tabs to create columns within the report.  Tabs are used to navigate 
between fields and cannot be typed into a report.  We have used a special fixed-width font 
to make spaces hold so teachers can print in columns.  If you are not sure how to create 
columns using spaces take a look at one of the test templates available in SpEd Forms.   
These test templates include columns and tables created using spaces rather than tabs. 

When working with spaces:  
· Use the Enter or Return key to move to another line.  Do not use the space bar to 

advance to the next line because the browser will treat the group of spaces as one 
character and force the right margin off the page when you print. 

· Before you add more spaces to a line, make sure there are not existing spaces on this 
line.  You can check this by using the arrow key to move right or by clicking to the 
right of the existing text (if the cursor jumps to where you click, spaces exist there). 

· If you choose a SpEd Forms template, click the mouse into the predefined spaces to 
enter measures. 
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17.3 Printing from SpEd Forms 
 

22. Can I print more than one page at a time? 
Using SpEd Forms, you may print the entire IEP, IFSP, IIIP and ER by clicking on the "Print..." 
button toward the top of each of these menus (some Mac OS X browsers do not support this this 
feature).  Additional Forms can be printed one page at a time. 
 

23. I clicked the "Print" button, but nothing happens. What did I do wrong? 
Only one print window will open at a time.  It's likely your print window is already open in the 
background and the new print preview has loaded into it.  If you are on a PC, click ALT-TAB to 
cycle through the open browser windows until you find it.  If you are on a Mac, select the print 
window from the "Window" menu. 
 

24. (Mac OS Only) When I print, only the navigation buttons print. Where's my form? 
Make sure you click on the SpEd Forms print button (in the SpEd Forms navigation bar) and then 
print from the print preview window.  If you select File>>Print without going to the print preview 
screen, only the heading will print. 
 

25. When I print, the web page address and other information prints. How do I prevent that 
from printing? 
Your browser should be setup to not print headers or footers.  You'll find this setting in your page 
setup or print setup window.  Please refer to the "Printing Setup" found on Section 1.1 of the User 
Guide. 
 

26. I seem to be only able to print the first goal/transition page. I am able to print the other goal 
pages when I first create them but not when I go back. 
The problem you are experiencing is probably related to the cache setup of your browser.  Please 
refer to the Setup procedures found on Section 1.1 of the User Guide. 
 

27. Can the print size be made larger? 
Yes.  To make the printed font larger navigate to "Your Setup" and click on "Profile".  Select the 
desired size from the "Print Font Size" drop down box.  Click "Save" to save your changes. 
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18. Where do I go for support? 
 
Step 1: Consult the SpEd Forms user guide 
Before requesting support please review the SpEd Forms User Guide. Most support questions are from 
users who have not completed the computer configuration (refer to Section 1.1 of the User Guide). 
Answers to most other questions asked by teachers can be found in Frequently Asked Questions (refer to 
Section 17 of the User Guide). 
 
Step 2: Contact your SpEd Forms administrator 
Your SpEd Forms Administrator is the person responsible for administering SpEd Forms for your school 
district. This person will be able to answer most questions about the program. Your designated SpEd 
Forms Administrator qualifies for technical support from SpEd Forms. 
 
Note: Be sure to give your SpEd Forms Administrator clear and concise information. The better 
information you provide, the more likely your problem will be solved in a timely manner. 
 
Step 3: Contact a coordinator or special education director 
If the SpEd Forms Administrator is unavailable, please contact your special education coordinator or 
special education director. These people also qualify for technical support from SpEd Forms. 
 
Note: SpEd Forms Inc. ONLY provides technical support to designated SpEd Forms Administrators, 
Special Education Coordinators and Special Education Directors. Your school district or organizational 
unit may have its own procedures. For example, most service cooperatives require questions to be directed 
to the SpEd Forms Administrator. 
 
If your district or organizational unit does not have a designated SpEd Forms Administrator, please 
contact your Special Education Director. Your Special Education Director can contact SpEd Forms to 
designate a SpEd Forms Administrator. Your SpEd Forms Administrator does not need special training 
but should be accessible to teachers. Their role is to answer common questions and verify issues before 
contacting SpEd Forms technical support. 
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